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Introduction

The SAMR30 Module Xplained Pro (XPro) evaluation kit is a hardware platform to evaluate the
performance of ATSAMR30M18A which is a Sub-1 GHz IEEE® 802.15.4™ compliant RF module. This
evaluation kit is supported by the Atmel Studio Integrated Development Platform (IDP), which provides
easy access to various ready-to-use applications supported by the Microchip ATSAMR30M18A module.
This user’s guide facilitates how to get started with the SAMR30 extension board and how to integrate the
module in a custom design. The extension board is designed to provide 802.15.4 wireless functionality to
the Xplained Pro evaluation platform in 700/800/900 MHz industrial, scientific and medical (ISM) band.

Features

• ATSAMR30M18A module is an IEEE 802.15.4 compliant wireless module for 700/800/900 MHz(1)(4)

applications
– ATSAMR30E18A (ARM® Cortex® -M0+) System-in-a-Package (SiP)
– Single-ended RF output through the PCB castellated pad
– Radio module with a link budget

• RX sensitivity up to -105(2)(4) dBm
• TX output power up to 8.7(2)(4) dBm

– High precision 16 MHz crystal oscillator
• On-board chip antenna for quick evaluation and an SMA connector for conducted measurements and

external antenna(3)

• On-board MCP2221A USB-UART/I2C convertor for observing console logs from the SAMR30
• On-board AT30TSE758A Digital Temperature Sensor

– Integrated temperature sensor, non-volatile registers, and serial EEPROM
– Two wire I2C and SMBus compatible serial interface

• On-board 4 Mb SPI Flash
• Footprint provision for evaluating CryptoAuthentication™ device ATECC608A/ATECC508A
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• Power supply options
– USB (Default option selected by on-board power multiplexer)
– Host XPro through extension header
– Battery header

• Standalone operation with power supplied through USB header
• Current measurement header
• Debug SWD header
• Digital I/O

– Xplained Pro extension header comprising SPI, I2C, and UART interfaces of the
ATSAMR30M18A

– One RESET button and one user button
– Two user LEDs
– One LED for power indication
– One QTouch® button

• Supports Performance Analyzer example application in Atmel Studio
• Operating temperature range is from -40°C to +85°C
• Xplained Pro hardware identification system

Note: 
1. The chip antenna supports only the 858-928 MHz band. The rest of the frequency bands supported

by the ATSAMR30M18A module can be evaluated through the on-board SMA connector.
2. When fRF=868.3 MHz, BPSK-20.
3. By default, the chip antenna is connected to the RF output of the module. The SMA connector

(J106) can be connected to the RF trace by removing L106 and mounting R115. For the schematic,
refer to SAMR30 Module XPRO design documentation on the Microchip website: https://
www.microchip.com/DevelopmentTools/ProductDetails/AC164159

4. The SMA connector is intended to be used only for laboratory evaluation purposes. For field usage
in USA/Canada, the antenna port must be of type RP(Reverse Polarity)-SMA.

 SAMR30 Module XPro
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1. Kit Overview
The SAMR30 module XPro is a carrier board for evaluation of the ATSAMR30M18A module in Xplained
Pro evaluation platform. This evaluation kit can be operated in the standalone mode by powering the
board through the USB header, or can be connected with any Xplained Pro standard extension header on
any Xplained Pro MCU board to evaluate IEEE 802.15.4 wireless functionality in 700/800/900 MHz ISM
band.

Figure 1-1. SAMR30 Module Xplained Pro
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1. Battery header (J102)
2. Battery/LDO Selection header (J103)
3. Current measurement header (J104)
4. Power LED
5. USB header
6. XPRO Extension header
7. User LEDs
8. QTouch button
9. Reset button
10. User button
11. Cortex DBG (Debug) header

 SAMR30 Module XPro
Kit Overview
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2. Getting Started
This chapter provides the prerequisites to start the evaluation with the SAMR30 Module Xplained Pro
evaluation kit.

2.1 Xplained Pro Quick Start
This section provides the steps to explore the SAMR30 Module Xplained Pro platform. The SAMR30
Module XPro boards are programmed at factory with Performance Analyzer firmware along with
AVR2054 bootloader. For the users with a fresh board from factory, follow instructions in Section 2.1.1 
Setup for Standalone Operation and Section 2.2.1  Programming Wireless Assembly using Atmel Studio
7.0 (skip Step 7 and 8) for setup and follow the instructions in Section 2.2.2  Installing Wireless Composer
7.0 Extension in Atmel Studio 7.0 to install wireless composer and to get started with Performance
Analyzer GUI.

The bootloader memory section (8kB) is write-protected at factory. To overwrite the write-protection,
program the BOOTPROT bits[2:0] of NVM User Row with the default value of 0x7.

Customers not making use of the bootloader must program the BOOTPROT bits to default value to
program the complete flash of the SAMR30 device. To download FW through bootloader, connect the
board to PC as shown in Figure 2-1 and follow the instructions to load application firmware to an MCU
through the Bootloader PC tool given in the AVR2054 application note.

Once the Xplained Pro kit is powered, the green power LED glows. The target device can be
programmed and debugged by an external programmer or debugger tool like Atmel-ICE or SAM-ICE™.

2.1.1 Setup for Standalone Operation
The SAMR30 module XPro is designed to operate in the standalone mode with an external programmer/
debugger for evaluation. This requires the board to be powered from the USB header as shown in the
following figure.

Figure 2-1. SAMR30 Module XPro Powered from USB Header

Any of the standard XPro Extension boards can be interfaced with the SAMR30 module XPro board using
Xpander-XPro. The following is a sample image showing the reference for this setup.

 SAMR30 Module XPro
Getting Started
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Figure 2-2. SAMR30 Module XPro Interfaced with Standard XPro Extension Board

Note:  Due to the limited number of available GPIOs in the ATSAMR30M18A module, few pins available
in extension header of the board are multiplexed in the hardware through 0 Ohm resistors.

When interfacing with a standard XPro board, the user must verify the availability of GPIOs for
interfacing.

2.1.2 Connecting XPro with XPro Extension
The SAMR30 module Xpro extension board is designed to connect with an Xplained Pro extension
header (EXT1). However, it is compatible with all Xplained Pro EXT headers. See the pinouts of the
corresponding Xplained Pro evaluation kit to find which Xplained Pro EXT headers can be used. The
connection of the SAMR30 module XPro extension board with the SAM D21 Xplained Pro is shown in the
following figure. Similarly, the extension board can also be connected with any other XPros. For more
details, see SAM D21 Xplained Pro Evaluation Kit Documentation.

 SAMR30 Module XPro
Getting Started
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Figure 2-3. Connecting SAM D21 Xplained Pro with SAMR30 Module XPro Extension

Initially, the XPro board must be programmed with the respective serial bridge firmware and the SAMR30
module XPro extension board must be programmed with Performance Analyzer firmware.

Note:  By default, the Performance Analyzer example project for the SAMR30 module XPro is configured
to operate in the standalone mode, that is, the UART (SIO2HOST) is configured to the UART interfaced
with USB-UART convertor.

For evaluating the Performance Analyzer with an XPro board, the UART configuration in
conf_sio2host.h file of the project in Atmel Studio must be modified for EXT header UART.

After programming both the XPro and extension boards, the Performance Analyzer GUI in Atmel Studio
can connect with the SAMR30 wireless module on the extension board, which allows the user to change
the channel, transmit power, modulation scheme, and so on. to perform RF tests. For more details on
programming steps for both XPro and extension board, see Programming Wireless Assembly using Atmel
Studio 7.0.

2.1.3 Programming BOOTPROT Bits to Default Value
Perform the following steps to program BOOTPROT bits to default value.

1. Open Atmel Studio.
2. Choose Device Programming from Tools menu.
3. In the Device Programming window, set the following.

– Tool – Atmel-ICE or SAM-ICE
– Device – ATSAMR30E18A
– Interface – SWD

4. Click Read to read the device signature and target voltage.
5. Click the Fuses tab in the left pane and enter 0x7 in the USER_WORD_0.NVMCTRL_BOOTPROT

field.
6. Click Program.

 SAMR30 Module XPro
Getting Started
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Figure 2-4. Device Programming

2.2 Performance Analyzer
The Performance Analyzer firmware with a GUI (Wireless Composer Extension) in Atmel Studio provides
a way to perform a number of basic RF functional tests. A quick-start guide and general help are
available in the starting page of Performance Analyzer window of the Atmel Studio. The latest version of
Atmel Studio is 7.0.

This section guides the user to install the necessary wireless extension, and to program the wireless
assembly using Atmel Studio 7.0.

2.2.1 Programming Wireless Assembly using Atmel Studio 7.0
The following steps explain how to program the SAMR30 Module XPro board and get started with the
Performance Analyzer application.

1. Connect the USB header of the SAMR30 Module XPro board with PC using the USB cable to
power on the board. Virtual COM port driver installation begins and the driver installation fails.

2. Navigate to Device Manager (Start > Search for Device Manager). The connected device will be
available under Other devices as MCP2221 USB-I2C/UART Combo.

 SAMR30 Module XPro
Getting Started
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Figure 2-5. Device Manager

3. Right click MCP2221 USB-I2C/UART Combo device name and click Update Driver Software....
Figure 2-6. Update Driver Software

4. Download the MCP2221 USB driver files from the MCP2221A webpage.
5. Select Browse my computer for driver software and specify the path of the folder containing the

MCP2221 USB driver.
6. USB driver installation is complete and the device will be listed as USB Serial Port as shown in the

following image. Note the COM number displayed next to the USB Serial Port from the Device
Manager. This COM number is used to establish connection with the kit.

 SAMR30 Module XPro
Getting Started
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Figure 2-7. Device Manager Listing USB Serial Port

7. Connect the 10-pin 50 mil header from the programmer/debugger (like Atmel-ICE) with the Cortex
DBG (Debug) header of SAMR30 Module XPro extension board.

8. Open Atmel Studio.
9. Navigate to the menu File>New>Example Project.
10. Select SAMR30 from the Device Family drop-down list.
11. Enter Performance analyzer in the field "Search for Example Projects". Select "Performance

Analyzer Application AT86RF212B - SAM R30 Module Xplained Pro". The example project will be
created in the selected directory.

 SAMR30 Module XPro
Getting Started
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Figure 2-8. Selecting Performance Analyzer Application

12. After the project solution is successfully opened, initiate the Build by clicking 'Build solution' from
Build menu.

13. Connect an external debugger like Atmel-ICE to SAMR30 Module XPRO as shown in the following
figure.
Figure 2-9. Connecting Programmer/Debugger with SAMR30 Module XPro Extension Board

14. After successful build completion, open the Device Programming window from the Tools menu.

 SAMR30 Module XPro
Getting Started
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15. In the Device Programming window, set the following.
– Tool – Atmel-ICE
– Device – ATSAMR30E18A
– Interface – SWD

16. Click Read to read the device signature and target voltage.
17. Navigate to Memories tab, click Program.

Figure 2-10. Device Programming

18. Open the Performance Analyzer GUI from the Tools menu in Atmel Studio.
19. Follow the Quick Start guidelines available in the starting page of Performance Analyzer window.
20. Select COM port, and click connect. The Performance Analyzer connects with SAMR30 Module

XPro on the board.
The Performance Analyzer allows setting/changing of the parameters like Channel Page, Channel,
TX Power Register Value, and so on. To perform various RF tests. For more details about the
usage of the Performance Analyzer, click help as shown in the following figure.

 SAMR30 Module XPro
Getting Started

© 2018 Microchip Technology Inc.  User Guide DS50002827A-page 13



Figure 2-11. Performance Analyzer - Help

2.2.2 Installing Wireless Composer 7.0 Extension in Atmel Studio 7.0
The following steps explain how to install the necessary wireless extension tool in Atmel Studio 7.0.

1. Install and open Atmel Studio.
2. Go to Tools menu and click Extensions and Updates...

Figure 2-12. Extensions and Updates Menu Option

3. In the Extensions and Updates window, click Available Downloads.
4. Expand All options on the left navigation pane, and click Wireless.

 SAMR30 Module XPro
Getting Started
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5. Select Wireless Composer 7.0 and click Download, which leads to Microchip Gallery.
Figure 2-13. Extensions and Updates Window

6. Log in to the Microchip Gallery with myMicrochip account.
Figure 2-14. Microchip Gallery Dashboard

7. Search for Wireless Composer in the search bar and click the latest version.

 SAMR30 Module XPro
Getting Started
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Figure 2-15. Wireless Composer Page

8. On the webpage of the extension, click Download and when prompted for file download, click
Open. The extension automatically installs after completion of the download.

9. Install Wireless Composer.
Figure 2-16. VSIX Installer

10. Restart Atmel Studio after the installation. The Performance Analyzer GUI will be available in the
Tools menu.

 SAMR30 Module XPro
Getting Started
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Figure 2-17. Performance Analyzer Menu Option

2.3 Design Documentation and Relevant Links
Following is a list of links to the most relevant documents and software for the SAMR30 module XPro
extension board:

• Xplained Pro products– Xplained Pro is a series of small-sized and easy-to-use evaluation kits for
Microchip microcontrollers and other Microchip products. It consists of a series of low-cost MCU
boards for evaluation and demonstration of features and capabilities of different MCU families.

• SAMR30 Module XPro Design Documentation package containing schematics, BOM, assembly
drawings, 3D plots, layer plots, and so on.

• Atmel Studio, free Microchip IDP for development of C/C++ and assembler code for Microchip
microcontrollers.

• Data Visualizer is a program used for processing and visualizing data. Data Visualizer can receive
data from various sources, such as the Embedded Debugger Data Gateway Interface found on
Xplained Pro boards and COM ports.

• Wireless composer provides the Wireless Performance Analyzer and IEEE 802.15.4 MAC Project
Wizard. Wireless Performance Analyzer is used to demonstrate various features and capabilities of
Microchip IEEE 802.15.4 Transceivers and BLE Transceivers.

• SAMR30 Module XPro product page.
• ATSAMR30M18A – Product page for the SAMR30 wireless module
• ATSAMR30E18A – Product page for the ATSAMR30 ARM Cortex M0+ based wireless

microcontroller.
• ATSHA204A-MAHCZ-T – Product page for the Standard XPro extension board ID chip.
• AT30TSE758A – Product page of on-board Digital temperature sensor
• ATECC508A – Product page for CryptoAuthentication IC
• ATECC608A – Product page for CryptoAuthentication IC
• AT25DF041B-SSHN-T – Product page for on-board SPI Flash
• MCP2221A – Product page for MCP2221A, USB 2.0 to I2C/UART protocol converter with GPIO
• AVR2054 Application Note.

 SAMR30 Module XPro
Getting Started
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3. Xplained Pro
The Xplained Pro is an evaluation platform that provides the full Microchip microcontroller experience.
The platform consists of a series of Microcontroller (MCU) boards and extension boards that are
integrated with Atmel Studio, which has Advanced Software Framework (ASF) drivers and demo code to
support data streaming, and more. The Xplained Pro MCU boards support a wide range of Xplained Pro
extension boards, which are connected through a set of standardized headers and connectors. Each
extension board has an identification (ID) chip to uniquely identify which boards are connected to an
Xplained Pro MCU board. This information is used to present relevant user guides, application notes,
data sheets, and example code through Atmel Studio.

3.1 Hardware Identification System
All Xplained Pro compatible extension boards have a Microchip ATSHA204 CryptoAuthentication chip
mounted. This chip contains information that identifies the extension with its name and some extra data.
When an Xplained Pro extension is connected to an Xplained Pro MCU board, the information is read
and sent to Atmel Studio. The Atmel extension kits installed with Atmel Studio provide information, code
examples, and links to relevant documents. The following table shows the data fields stored in the ID chip
with example content.

Table 3-1. Xplained Pro ID Chip Content

Data Field Data Type Example Content

Manufacturer ASCII string Microchip\0'

Product name ASCII string Segment LCD1 Xplained Pro'\0'

Product revision ASCII string 02'\0'

Product serial number ASCII string 1774020200000010’\0’

Minimum voltage [mV] uint16_t 3000

Maximum voltage [mV] uint16_t 3600

Maximum current [mA] uint16_t 30

3.2 Xplained Pro Standard Extension Header
All Xplained Pro kits contain one or more dual row, 20-pin, 100 mil extension header(s). The Xplained Pro
MCU boards have male headers, while Xplained Pro extensions have their female counterparts.
Note:  All pins are not always connected.

The extension headers can be used to connect a variety of Xplained Pro extensions to Xplained Pro MCU
boards, or to access the pins of the target MCU on Xplained Pro MCU boards directly.

The following table provides the pin description of all the connected pins.

Pin Number Name Description

1 ID Communication line to the ID chip on an extension board

2 GND Ground

 SAMR30 Module XPro
Xplained Pro
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...........continued
Pin Number Name Description

3 ADC(+) Analog-to-Digital converter, alternatively positive part of differential ADC

4 ADC(-) Analog-to-Digital converter, alternatively negative part of differential ADC

5 GPIO1 General purpose I/O

6 GPIO2 General purpose I/O

7 PWM(+) Pulse width modulation, alternatively positive part of differential PWM

8 PWM(-) Pulse width modulation, alternatively negative part of differential PWM

9 IRQ/GPIO Interrupt request line and/or general purpose I/O

10 SPI_SS_B/

GPIO

Slave select for SPI and/or general purpose I/O

11 I2C_SDA Data line for I2C interface

12 I2C_SCL Clock line for I2C interface

13 UART_RX Receiver line of target device UART

14 UART_TX Transmitter line of target device UART

15 SPI_SS_A Slave select for SPI. This pin must be preferably unique.

16 SPI_MOSI Master out slave in line of serial peripheral interface

17 SPI_MISO Master in slave out line of serial peripheral interface

18 SPI_SCK Clock for serial peripheral interface

19 GND Ground

20 VCC Power for extension board

 SAMR30 Module XPro
Xplained Pro
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4. Hardware Specifications
This chapter explains the connectors, headers, and other peripherals of the SAMR30 module XPro.

4.1 Headers and Connectors

4.1.1 SAMR30 Module XPro Extension Header (J100)
The SAMR30 module XPro has a standard Xplained Pro Extension Header (EXT) which is a 20-pin 100
mil pitch female header. This header helps to connect the board to any Xplained Pro MCU board. The
pinout definition for the extension header is shown in the following table.

Table 4-1. SAMR30 Module XPro Extension Header (J100)

Pin on
EXT Function ATSAMR30

Module Pin Description Shared Functionality

1 ID_DATA - Communication line to ID chip -

2 GND GND Ground -

3 ADC(+) PA06 AIN[6]; ADC pin. Connected by
default. This pin can be
disconnected by unmounting
R106.

EXT pin 9 and QTouch
Button

4 ADC(-) - Not Connected (NC) -

5 GPIO PA14 GPIO. Not connected by default.
This pin can be connected by
mounting R109.

EXT pin 13 and user 
LED 1 (D101)

6 GPIO - NC -

7 PWM(+) - NC -

8 PWM(-) - NC -

9 IRQ/GPIO PA06 GPIO. Not Connected by default.
This pin can be connected by
mounting R107.

EXT pin 3 and QTouch
Button

10 SPI_SS_B/GPIO PA28 GPIO. Connected by default.
This pin can be disconnected by
unmounting R103.

Alert pin of Temperature
sensor

11 TWI_SDA PA08 SERCOM0/PAD[0]. I2C Serial
Data Line (SDA) for data
transfer.

SDA – Temperature
sensor, ATECC608A
and USB-UART/I2C
convertor

12 TWI_SCL PA09 SERCOM0/PAD[1]. I2C Serial
Clock Line (SCL) for the bus
clock.

SCL – Temperature
sensor, ATECC608A
and USB-UART/I2C
convertor

 SAMR30 Module XPro
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...........continued
Pin on

EXT Function ATSAMR30
Module Pin Description Shared Functionality

13 UART_RX PA14 SERCOM2/PAD[2]. UART
Transmit line of SAMR30.
Connected by default. This pin
can be disconnected by
unmounting R108.

EXT pin 5 and user LED
1(D101)

14 UART_TX PA15 SERCOM2/PAD[3]. UART
Receive line of SAMR30

-

15 SPI_SS_A PA17 SERCOM1/PAD[1]. Slave select
for SPI.

-

16 SPI_MOSI PA18 SERCOM1/PAD[2]. Master out
slave in line of SPI.

MOSI of SPI Flash and
user LED 2(D102)

17 SPI_MISO PA16 SERCOM1/PAD[0]. Master in
slave out line of Serial peripheral
interface. MISO of SPI Flash.

MISO of SPI Flash

18 SPI_SCK PA19 SERCOM1/PAD[3]. Clock for
Serial peripheral interface. SCK
of SPI Flash.

SCK of SPI Flash

19 GND GND Ground -

20 VCC_TARGET - Power for extension board -

4.1.2 USB Header (J101)
The USB Header (J101) is used for supplying power to the board and for interfacing the UART from
ATSAMR30M18A through the on-board UART-USB converter. For more details, see 4.2.7  USB-
UART/I2C Convertor (U103).

4.1.3 Battery Header (J102)
A battery can be used to power-up the board using the Battery Header (J102). The positive terminal of
the header is marked with ‘+’ in the PCB silk screen. This is a secondary option to power-up the board.
This mode of power-up can be used for operating in the standalone mode. The primary mode of power
source is through the USB header. J102 can also be used to evaluate the ATSAMR30M18A module
across operating voltage range (1.8 V to 3.6 V) with power supplied from a standard bench power supply.
To power the board from the battery header, place a jumper cap between pins 1 and 2 of Battery/LDO
Selection header (J103)

4.1.4 Battery/LDO Selection Header (J103)
The Battery/LDO Selection Header is used to select between the power, supplied through the LDO/EXT
header, and the battery header. This board has an on-board discrete power multiplexer, which chooses
between the power supplied from the USB header and the EXT header. Among the two, the highest
priority is assigned for the USB header.

 SAMR30 Module XPro
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Table 4-2. Battery/LDO Selection Header Pin Details

Pin on Connector Description

1 Power from battery header

2 Power to the module

3 Power from either USB header or EXT header

For powering the board from the battery, place the jumper cap between pins 1 and 2 of J103. For
powering the board from either USB header or EXT header, place the jumper cap between pins 2 and 3
of J103.

4.1.5 Current Measurement Header (J104)
The Current Measurement Header (J104) can be used to measure the current consumed by the
ATSAMR30M18A module. To measure the current consumption, perform the following:

1. Remove the power supply to the board
2. Remove the jumper cap placed over J104
3. Connect an ammeter/multimeter across the pins of J104
4. Provide power supply to the board

4.1.6 Serial Wire Debug Header (J105)
The Serial Wire Debug (SWD) Header is available on the board for programming and debugging the
ATSAMR30M18A wireless module. The pinout of this header is compatible with the SAM connector port
of the Atmel-ICE. The header can be interfaced with SAM-ICE using the ATATMEL-ICE-ADPT accessory
kit.

Table 4-3. SWD Header

Pin on Connector Module Signal

1 VCC_P3V3

2 SWDIO

3 GND

4 SWDCLK

5 GND

6 NC

7 NC

8 NC

9 GND

10 RESET

4.2 Peripherals
The following sections describe the peripherals and connection details of the SAMR30 Module Xplained
Pro.

 SAMR30 Module XPro
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4.2.1 LED
There are two user LEDs (Yellow – D101 and Green – D102) on the board that can be optionally
controlled by the SAMR30 module. The LEDs can be activated by driving the connected I/O line to GND.

The SAMR30 Module XPro board also contains one power indication LED (Green – D103).

Table 4-4. LED Functions

SAMR30 Pin Function Shared Functionality

PA14 Yellow LED D101. Connected by default. This pin
can be optionally disconnected by unmounting
R122.

UART TX of the SAMR30 and EXT
Pin 5

PA18 Green LED D102. Connected by default. This pin
can be optionally disconnected by unmounting
R123.

SPI MOSI of the SAMR30

4.2.2 Mechanical Buttons
The SAMR30 Module Xplained Pro contains two mechanical buttons:

• RESET button connected to the SAMR30 reset line.
– When the RESET button is pressed, the reset line is driven to GND.

• Generic user-configurable button. This GPIO can be used as a wake-up source from the Backup
mode of the SAMR30.

– When user-configurable button is pressed, the I/O line is driven to GND.

Table 4-5. Mechanical Buttons Functions

SAMR30 Pin Silkscreen Text Shared Functionality

RESET RST -

PA07 SW100 -

4.2.3 QTouch Button
A self capacitance button is available on the SAMR30 Module Xplained Pro board that can be used as
user input. This QTouch button is driven by the built-in Peripheral Touch Controller (PTC) of the SAMR30.
The 10 kOhm resistor in series to the QTouch button can be optionally removed to disconnect the QTouch
button from the module pin (PA06). This 10 kOhm series resistor improves the noise immunity of the
QTouch button.

Table 4-6. QTouch Button Functions

SAMR30 Pin Silkscreen Text Shared Functionality

PA06 QT BTN EXT pin 3 and 9

4.2.4 Temperature Sensor (U106)
The SAMR30 Module Xplained Pro has an on-board digital temperature sensor, AT30TSE758A. This
sensor is interfaced with the SAMR30 through I2C bus and is available on I2C slave address 0x48 (7-bit
MSb address).

The AT30TSE758A also has a serial EEPROM which is accessible through the same I2C bus with the
slave address as 0x50 (7-bit MSb address).

 SAMR30 Module XPro
Hardware Specifications

© 2018 Microchip Technology Inc.  User Guide DS50002827A-page 23



Table 4-7. Temperature Sensor Functions

SAMR30 Pin Function Shared Functionality

PA08 I2C SDA ATECC608A, USB-UART/I2C convertor and EXT pin
11

PA09 I2C SCL ATECC608A, USB-UART/I2C convertor and EXT pin
12

PA28 Alert. Not connected by default.
Could be connected by mounting
R126.

EXT pin 10

4.2.5 CryptoAuthentication Device (U105)
The SAMR30 Module Xplained Pro has a footprint provision for evaluating the Microchip
CryptoAuthentication ICs (ATECC508A and ATECC608A). The following table lists the interfaces
between the CryptoAuthentication IC and SAMR30.

Table 4-8. Crypto Authentication Device Functions

SAMR30 Pin Function Shared Functionality

PA08 I2C SDA Temperature sensor, USB-UART/I2C convertor and EXT pin 11

PA09 I2C SCL Temperature sensor, USB-UART/I2C convertor and EXT pin 12

4.2.6 Serial Flash (U101)
The SAMR30 Module Xplained Pro has an on-board 4 Mb SPI Flash for non-volatile storage of data.

Table 4-9. Serial Flash Functions

SAMR30 Pin Function Shared Functionality

PA16 SPI MISO EXT pin 17

PA18 SPI MOSI EXT pin 16

PA19 SPI SCK EXT pin 18

PA27 SPI SS/GPIO -

4.2.7 USB-UART/I2C Convertor (U103)
The SAMR30 Module Xplained Pro has an on-board USB-UART/I2C convertor primarily used as a Virtual
Com port gateway by using one of the SAMR30 UARTs.

Table 4-10. USB-UART/I2C Convertor Functions

SAMR30 Pin Function Shared Functionality

PA08 I2C SDA Temperature sensor, ATECC608A and EXT pin
11

PA09 I2C SCL Temperature sensor, ATECC608A and EXT pin
12

PA24 SERCOM3 PAD[2]. UART TX of the
SAMR30

-
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...........continued
SAMR30 Pin Function Shared Functionality

PA25 SERCOM3 PAD[3]. UART RX of the
SAMR30

-
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5. Regulatory Notice
This equipment (SAMR30 Module Xpro / A09-3182) is intended for laboratory evaluation purposes only.
The following regulatory notices are to cover the requirements under the regulatory approval.

When this module is used in USA/Canada, the user must restrict the operating frequency band within
902-928 MHz. Regulatory compliance settings have to follow the ATSAMR30M18A module certifications.

5.1 United States
The SAMR30 Module Xpro contains ATSAMR30M18A module which has received Federal
Communications Commission (FCC) CFR47 Telecommunications, Part 15 Subpart C “Intentional
Radiators” single-modular approval in accordance with Part 15.212 Modular Transmitter approval.

Contains Transmitter Module FCC ID: 2ADHKR30M.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can radiate
radio frequency energy, and if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected
• Consult the dealer or an experienced radio/TV technician for help

5.2 Canada
The SAMR30 Module Xplained Pro contains ATSAMR30M18A module which has been certified for use in
Canada under Innovation, Science, and Economic Development (ISED, formerly Industry Canada) Radio
Standards Procedure (RSP) RSP-100, Radio Standards Specification (RSS) RSS-Gen and RSS-247.
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This device contains license-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and
Economic Development Canada’s license-exempt RSS(s). Operation is subject to the following two
conditions:

1. This device may not cause interference;
2. This device must accept any interference, including interference that may cause undesired

operation of the device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR
d’Innovation, Sciences et Développement économique Canada applicables aux appareils radio exempts
de licence. L’exploitation est autorisée aux deux conditions suivantes:

1. L’appareil ne doit pas produire de brouillage;
2. L’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible

d’en compromettre le fonctionnement.

Transmitter Antenna (From Section 6.8 RSS-GEN, Issue 5, April 2018): User manuals, for transmitters
shall display the following notice in a conspicuous location:

This radio transmitter [IC: 20266-R30M] has been approved by Innovation, Science and Economic
Development Canada to operate with the antenna types listed below, with the maximum
permissible gain indicated. Antenna types not included in this list that have a gain greater than
the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Le présent émetteur radio [IC: 20266-R30M] a été approuvé par Innovation, Sciences et
Développement économique Canada pour fonctionner avec les types d'antenne énumérés ci-
dessous et ayant un gain admissible maximal. Les types d'antenne non inclus dans cette liste, et
dont le gain est supérieur au gain maximal indiqué pour tout type figurant sur la liste, sont
strictement interdits pour l'exploitation de l'émetteur.

Immediately following the above notice, the manufacturer shall provide a list of all antenna types which
can be used with the transmitter, indicating the maximum permissible antenna gain (in dBi) and the
required impedance for each antenna type.

For a list of approved antennas, refer to Table 5-1.

5.3 Europe
This equipment (A09-3182) has been assessed under the Radio Equipment Directive (RED) for use in
European Union countries. A Declaration of Conformity must be issued for each of these standards and
kept on file as described in Radio Equipment Directive.

Furthermore, the manufacturer must maintain a copy of the module's documentation and ensure the final
product does not exceed the specified power ratings, antenna specifications, and/or installation
requirements as specified in the user manual. If any of these specifications are exceeded in the final
product, a submission must be made to a notified body for compliance testing to all required standards.
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Important:  On account of the nature of radio equipment, the height of the CE marking affixed
to radio equipment may be lower than 5 mm, provided it remains visible and legible.
For more detailed information about CE marking requirements, refer to Article 19 of
“DIRECTIVE 2014/53/EU OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL” of 16
April 2014.

SIMPLIFIED EU DECLARATION OF CONFORMITY

Hereby, Microchip Technology Inc. declares that the radio equipment type [A09-3182] is in compliance
with Directive 2014/53/EU.

The full text of the EU declaration of conformity is available at the following URL (refer product specific
pages): http://www.microchip.com/design-centers/wireless-connectivity/.

5.4 Antenna Considerations
The following table provides the list of approved external antennas along with the manufacturer and part
number details.

Table 5-1. Approved Antennas

Manufacturer Part Number Antenna Type Peak Gain Operating
Frequency

Linx Technologies ANT-916-CW-QW-
SMA/ANT-916-
CW-QW(1)

Monopole antenna 1.8 dBi 865-965 MHz

Pulse Electronics W1910/W1911(1) Monopole Antenna 1.0 dBi 824-960 MHz, and
1710-2170 MHz

Note: 
1. The SMA connector is intended to be used only for laboratory evaluation purposes. For field usage

in USA/Canada, the antenna port must be of type RP (Reverse Polarity)-SMA.
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6. Hardware Revision History and Known Issues

6.1 Identifying Product ID and Revision
The revision and product identifier of the SAMR30 Module Xplained Pro can be found by looking at the
sticker on the bottom side of the PCB. The identifier and revision are printed in plain text as A09-xxxx Rev
rr, where xxxx is the identifier and rr is the revision. In addition, the label contains a 10-digit serial number
unique to each board.

The product identifier for the SAMR30 Module Xplained Pro is A09-3182.

6.2 Revision 4
Added option to bypass (through a 0R(R133) resistors which is not populated by default) the on-board
power switch to allow the power supply from USB header to supply external boards connected to EXT
header. This will be needed for standalone operation of the board with extension boards, indicated in
section 2.1.1.

Inserted 100ohm series resistors for module pins 3, 4, 6, 17, 19 and 20.

6.3 Revision 3
PCBA label has been updated to include final regulatory IDs.

6.4 Revision 2
Revision 2 is the initial revision of the SAMR30 Module Xplained Pro.
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7. Appendix

7.1 Connecting a SAM-ICE to an Xplained Pro Board
The Xplained Pro kits that feature a 10-pin 50-mil debug connector can use external debug tools like
SAM-ICE or Atmel-ICE for programming/debugging. Evaluation kits with devices using the SWD interface
on-board have a connector that is pinout-compatible with the Cortex Debug Connector.

The SAM-ICE is connected to the debug connector on an Xplained Pro using either an Atmel-ICE
adapter, SAM-ICE adapter, or a 10-pin 50-mil header to squid cable. When using a squid cable, see the
following table and figures for how to connect the SAM-ICE to the Xplained Pro board.
Table 7-1. Squid Cable Connections

Squid Cable Pin SAM-ICE Pin

1 (VCC) 1 (VTref)

2 (SWDIO/TMS) 7 (TMS)

3 (GND) 4 (GND)

4 (SWCLK/TCK) 9 (TCK)

5 (GND) 6 (GND)

6 (SWO/TDO) 13 (TDO) (1)

7 (Not used) -

8 (Not used) -

9 (Not used) -

10 (RESET) 15 (RESET)

Note: 
1. Optional pin is used only when the device functionality supports TDO.
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Figure 7-1. SAM-ICE using a Squid Cable

Figure 7-2. SAM-ICE using an Atmel-ICE Adapter
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8. Document Revision History
Revision Date Section Description

A 12/2018 Document Initial release
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests, online
discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BitCloud,
chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq,
Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, SAM-BA, SpyNIC, SST,
SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight
Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom,
CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM,
dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming,
ICSP, INICnet, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, memBrain, Mindi, MiWi,
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE,
Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are
trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of
Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
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ISBN: 978-1-5224-4007-9

Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer
fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC®

DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design and manufacture of development
systems is ISO 9001:2000 certified.
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